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Statements and Notices

Notice regarding 
Dranetz' 
proprietary 
rights

By accepting and using this manual, the user agrees that the information 
contained herein will be used solely for the purpose of operating equipment of 
Dranetz Technologies, Inc. This publication is protected under the copyright 
laws of the United States Title 17 et seq.

Copyright  Dranetz DRAN-LINK software documentation and software are copyrighted 
with all rights reserved. Under the copyright laws of the United States, neither 
the documentation nor the software may be copied, photocopied, reproduced, 
translated, or reduced to any electronic medium or machine readable form, in 
whole or in part, without the prior consent of Dranetz Technologies, Inc., except 
in the manner described in the following paragraph.

The recipient of the software hereby agrees that the proprietary information of 
the program is privileged and amounts to a trade secret and that he or she will 
take reasonable care not to disclose such information to any third parties, nor 
will he or she transfer programs for consideration or otherwise to any third 
party. The recipient has the right to make an archival copy and one working 
copy (for a total of two copies) of the program diskettes for use on one machine 
forever. No other copies of the program diskettes can be made, and no additional 
copies of the documentation can be made.

Copyright - 1996
Dranetz Technologies, Inc.
1000 New Durham Road
Edison, New Jersey 08818-4019
(908) 287-3680

All Rights Reserved
Printed in the United States of America

Continued on next page
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Statements and Notices, continued

Limitation of 
liability

Dranetz Technologies, Inc. does not warrant that the software program will 
function properly in every hardware/software environment. The software may 
not work in combination with modified versions of the operating system, with 
certain print-spooling or file facility programs, or with certain computers or 
printers supplied by independent manufacturers.

Although Dranetz Technologies, Inc. has tested the software and reviewed the 
documentation, Dranetz Technologies, Inc. makes no warranty or 
representation, either express or implied, with respect to this software or 
documentation, including its quality, performance, merchantability, or fitness 
for a particular purpose. As a result, this software and documentation are 
licensed as is, with the licensee assuming the entire risk as to their quality and 
performance.

In no event will Dranetz Technologies, Inc. be liable for direct, indirect, special, 
incidental, or consequential damages arising out of the use or the inability to use 
the software or documentation, even if advised of the possibility of such 
damages. In particular, Dranetz Technologies, Inc. is not responsible for any 
costs including but not limited to those incurred as a result of lost profits or 
revenue, loss of use of the computer program, loss of data, the cost of substitute 
programs, or any claims by third parties.

Revision rights Dranetz Technologies, Inc. reserves the right to revise this publication from time 
to time and to make changes in its content without any obligation of notifying 
previous users of such revisions or changes.

Trademarks DRAN-LINK is a trademark of Dranetz Technologies.

IBM is a registered trademark and IBM Personal Computer (386/486) are 
trademarks of International Business Machines, Inc.

Windows is a trademark of Microsoft Corporation.

Statement of 
reliability

The information in this manual has been reviewed and is believed to be entirely 
reliable, however, no responsibility is assumed for any inaccuracies. All 
material is for informational purposes only and is subject to change without 
prior notice.
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Chapter 1

Introduction

Overview This chapter provides a description of DRAN-LINK 4300, the DRAN-LINK 
4300 software package contents, equipment required to run DRAN-LINK 4300, 
reference manuals, and a description of the contents of this manual. 

DRAN-LINK 
4300 description

Dranetz DRAN-LINK 4300 is a communications interface application which 
permits transferring (downloading) stored data from the Power Platform 4300 to 
a disk file. DRAN-LINK 4300 enables communication with the PP4300 via a 
standard RS-232 serial port on the host PC utilizing an optically isolated 
communications module. With DRAN-LINK 4300 you can choose to download 
internal memory or download a memory card (if one is installed). Data is saved 
to a file which can then be viewed with DRAN-VIEW. 

Product features Product features are:

• Support for RS-232 communication using PC standard serial ports COM1 
through COM4.

• Plug-and-play auto-detection of connected device eliminates need to 
manually select serial port.

• Fault-tolerant communication recovery scheme permits short term 
interruption of communications with no loss of data.

• File compatibility with the DRAN-VIEW Browser.

Package 
contents

The DRAN-LINK 4300 software package consists of:

• One, 3 1/2 inch installation disk
• Dranetz DRAN-LINK Operator’s Manual, OM-DRANLINK (this manual)
• Registration Card.

Registration 
card

Please fill in the registration card provided in the shipping carton and mail 
it today. The information requested will allow Dranetz to provide you with 
the necessary support and up-to-date information on future developments 
in Dranetz software and hardware.

Continued on next page
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Equipment 
required

To operate the DRAN-LINK 4300 software you must have the following 
equipment available:

• Dranetz Power Platform, Model 4300 with its Battery Charger/Eliminator
• Isolated Communications Module, PP4300RS232
• Personal Computer or Laptop Computer with a Windows operating system 

and a serial communications port. (See page 2-1 for details.)

Reference 
manuals

Refer to the following manuals for reference information related to the 
equipment required:

• 4300 Operator’s Manual, Part Number OM-4300-PQLITE
• Information Sheet for Isolated Communications Module, part no. 899029 
• DRAN-VIEW Operator’s manual, part number OM-4300-DRANVIEW
• Personal/Laptop Computer Operating Manual

Installing the 
4300 to a PC

To install DRAN-LINK 4300 to a personal computer, refer to the Information 
Sheet for the Communications Module referenced above.

Previous 
computer 
knowledge

This manual is written with the understanding that you have a basic knowledge 
of computers; specifically, the IBM-PC family of computers or compatibles 
presently available, and operating in a Windows environment.

This manual This manual contains instructions for installing and operating the DRAN-LINK 
software. It consists of the following:

Customer 
support

The technical support phone number for DRAN-LINK 4300 is:
1-800-DRANTEC (1-800-372-6832)

The technical support FAX number is:
1-908-248-1834

Chapter 2 - Launching the Software

Chapter 3 - Main Menu Commands
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Chapter 2

Launching the Software

Overview This chapter contains information dealing with computer requirements and 
installing the software. The PP 4300 need not be connected to install the 
software.

In this chapter The following topics are covered in this chapter.

Reviewing 
computer 
requirements

To run DRAN-LINK, computer requirements are as follows: 

• Processor: 386 or higher
• Operating System: MS-Windows, version 3.1 or higher (including
   Windows 95)
• Memory Requirements: 8 MB or greater
• Disk Requirements: 1.5 MB for installation.

Continued on next page

Topic See Page

Reviewing Computer Requirements below

Installing DRAN-LINK software 2-2

Starting DRAN-LINK 2-4

Selecting DRAN-LINK Help 2-6
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Installing DRAN-LINK Software

Introduction DRAN-LINK must be installed on your hard disk in its own directory. The setup 
program will create a default directory titled C:\DRANLINK, and a group 
called Dranetz Power Suite, unless you specify a different one. The program 
must be installed from Windows.

To install the software, the computer need not be connected to the PP4300.

DRAN-LINK 
directory

DRAN-LINK must be installed on your hard disk in its own directory. The setup 
program will create a default directory titled C:\DRANLINK unless you specify 
a different one. The program must be installed from Windows.

Procedure  Install the software as follows:

Continued on next page

Step Action

1 Install the DRAN-LINK disk into your a:\ drive.

2 From the File Manager select drive a:\.

3 Click on setup.exe. The message “Please Wait - Copying 
Installation to Temporary Directory” message is displayed.

4 The Select Installation Drive window is displayed. 

Select a fixed drive to receive the software. Highlight selected 
drive and double-click left mouse button. Normal selection is 
drive c:\. 
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Installing DRAN-LINK Software

Procedure, 
continued

DRAN-LINK 
icons

5 The Setup window is displayed. Default directory is 
C:\DRANLINK. 

6 Make your choice and press <Enter> or click on OK for selection 
of the default directory shown.

7 “Installing Files” message is displayed.

8 Once files are installed, the “Finished Installing DRAN-LINK” 
message is displayed. Click on OK and the display reverts to the 
File Manager.
 

 

9 Select Windows Program Manager display. Note the DRAN-
LINK and HELP icons in the DRANETZ POWER SUITE display 
as shown below.
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Starting DRAN-LINK

DRAN-LINK 
icon

Double clicking the mouse left button on the DRAN-LINK icon will start the 
program and will display the Main Menu as shown on the next page. Refer to 
Chapter 3 for details of the Main Menu Commands.

Main Menu
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Starting DRAN-LINK, continued

Main Menu 
Display 
Description

 The following is a brief description of the areas contained in the Main Menu 
display that are referenced throughout this manual. The Main Menu display is 
defined as an application window that appears on the screen. For complete 
details refer to your Windows operating manual.

Caption bar - The top line contains the Control Menu command symbol on the 
left edge, the application name of DRAN-LINK 4300, and the Minimize and 
Maximize buttons on the right edge. Clicking on the Control Menu command 
will display the Control Menu which includes the following commands: 
Restore, Move, Size, Minimize, Maximize, Close, and Switch to. The 
underlined characters define the upper or lower case letter key used to select the 
command if the keyboard is used. Quick keys also are defined for the Close and 
Switch to commands.

Menu bar - The second line defines the commands available to select operating 
menus. The Commands that are dimmed are not available. Menus can be 
enabled with the mouse or with the keyboard selection of the underlined letter 
of the command. Note that the Browser command is dimmed if the DRAN-
VIEW application is not installed. The active menus are described in Chapter 3.

Tool bar - The third line contains two selectable tools for displaying 
information about copyright information and version of DRAN-LINK 4300 and 
for Help specific information. The tool bar display is controlled through the 
View Menu and can be turned on or off. 

Document Window - This main area is the display area for showing the pop-up 
menus, dialog boxes, and the data windows of the application.

Status bar - The bottom line of the window is displayed as the status bar. It 
describes actions of menu items as you use the mouse or arrow keys to navigate 
through menus. The small pane at the right edge of the bar displays the 
communication port being used to communicate with the PP 4300. The status 
bar is selected in the View menu.

Continued on next page
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Selecting DRAN-LINK Help

DRAN-LINK 
Help icon

Double clicking the mouse left button on the DRAN-LINK Help icon will 
display the LINK4300 Application Help Index screen shown below.
This index provides topical selections for an overview of DRAN-LINK, 
downloading setup, and how to get customer support. Command topics provide 
specific information on the Main Menu commands. These commands are 
described in Chapter 3 in detail.
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Chapter 3

Main Menu Commands

Overview This chapter describes the selection and application of the main menu 
commands consisting of File, View, Communications, Browser, and Help. All 
other commands are disabled. The communications commands are the major 
commands used to download information from the 4300 internal memory or 
memory card. To read the files, the DRAN-VIEW application program must be 
used.

In this chapter The following topics are covered in this chapter.

Continued on next page

Topic See Page

Entering the Software - Main Menu 3-1

File Menu 3-4

View Menu 3-5

Communicate Menu 3-7

Browser Menu 3-15

Help Menu 3-16

Exiting the Software 3-19
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Entering the Software, Main Menu

Introduction To execute the DRAN-LINK software, the DRAN-LINK icon in the Dranetz  
Power Suite program group, is double-clicked using the mouse. All commands 
for DRAN-LINK are executed from the Main Menu. The Main Menu is shown 
below.

Main Menu

Selecting 
commands

Commands are selected by positioning the mouse pointer over the command 
word and clicking the left mouse button. A pop-up menu will appear indicating 
further selections. Clicking on a selection will cause other pop-up menus or 
dialog boxes to appear to make further selections possible.

Active 
commands

Active commands appear in bold print and consist of File, View, Communicate, 
and Help.

Continued on next page
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Entering the Software, Main Menu, continued

Commands not 
available

Commands that are not available appear dimmed and consist of Edit, Configure, 
Scope, and Browser. Browser is available when DRAN-VIEW is installed.
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File Menu

Introduction Selection of the File command using the mouse, or ALT + F4 keys, will display 
the File menu. Exit is the only command available from the File menu.

Exit Use it to end your DRAN-LINK 4300 session. If you choose to exit DRAN-
LINK during a data transfer operation, DRAN-LINK must sign-off to the 
PP4300 to end communication. This process will normally take several seconds 
to complete so DRAN-LINK 4300 displays a wait message window during this 
time. 
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View Menu

Introduction Selection of the View command, using the mouse or ALT+V+T keys, will 
display the View Menu for selection of the Toolbar or Status Bar. Selection of 
either will show or hide the respective bar. A check mark will appear next to the 
menu items when the item is selected.

Toolbar  The toolbar is displayed across the top of the application window, below the 
menu bar. This version of DRAN-LINK disables all toolbar buttons except the 
About and Context Help buttons as shown below.

Refer to the description of the Help menu on page 3-16 for further description of 
Help functions.

 

Toolbar buttons

                                                    

                               
About button Selecting the About button will display the copyright notice and version number 

of your copy of DRAN-LINK as shown below.

Context Help 
button

Selecting the Context Help button will change the mouse pointer to an arrow 
and question mark symbol. Positioning this symbol over any command or menu 
item and clicking the mouse button will display a related help topic.

Continued on next page
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View Menu, continued

Status Bar  The Status bar is displayed at the bottom of the DRAN-LINK window. 

The status bar describes actions of menu items as you use the mouse or arrow 
keys to navigate through menus. This area similarly shows messages that 
describe the actions of toolbar buttons as you press them before releasing them. 
If you release the button on the toolbar button, then that operation will execute. 
If after viewing the description of the toolbar button command you wish not to 
execute the command, then release the mouse button while the pointer is off the 
toolbar button or out of the menu area.
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Communicate Menu

Introduction Selection of the Communicate command will display the Communicate menu. 
The Link menu command is the only active option available in the 
Communicate menu. Selecting Link produces a cascaded menu with the 
following choices:

• Download Internal Memory - Downloads data from the internal memory of 
the PP4300 to file.

• Download Memory Card - Downloads data from the memory card (if 
installed) of the PP4300 to file.

Note: Before attempting any downloading of data, the PP4300 must be 
connected to the computer. Refer to the Isolated Communications Module 
Information Sheet, part number 899029, for detailed information about the 
cabling and equipment required.

Download 
Internal 
Memory

DRAN-LINK 4300 will prompt for a file in which to save the download data 
using a File Save dialog. Once a filename has been specified, DRAN-LINK 
4300 attempts to establish communication with the PP4300 and, if successful, 
begins transferring data to the file. DRAN-LINK 4300 displays a progress 
indicator window during the transfer operation. The window has a Cancel 
button to permit termination of the transfer.

DRAN-LINK 4300 produces a message display to signal the end of the transfer 
operation. DRANLINK 4300 also produces an message display if the PP4300 
reports an error or the transfer operation is aborted at the PP4300.

Downloading the data from the Internal memory of the PP4300 takes about 3 
minutes.

Continued on next page
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Communicate Menu, continued

Download 
Internal 
Memory 
Procedure

 Perform the following procedure to download data from the internal memory of 
the PP4300 to a designated file.

Continued on next page

Step Action

1 Connect the PP4300 to the computer. Turn on power to the 
PP4300.

2 Select Communicate, Link, then Download Internal Memory 
commands. The following Save Data File display will appear.
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Communicate Menu, continued

Download 
Internal 
Memory 
Procedure, 
continued

Continued on next page

3  Using the following options, specify the name and location of the 
file you are about to save.

File Name
Type the filename in which you want to save the data. A file-
name can contain up to eight characters and an extension of up 
to three characters. Files must have an extension of .evt to 
work with DRANVIEW, typing any other extension will pro-
duce an error. If you provide a filename only (without exten-
sion) DRAN-LINK 4300 adds the .evt extension for you.

Drives
Select the drive in which you want to store the document. 
Datafiles created by downloading from a memory card are 
larger than can be saved on a floppy disk. These files must be 
saved on a hard disk or an error display will be produced.

4 Directories
Select the directory in which you want to store the datafile.

Network
Choose this button to connect to a network location, assigning 
it a new drive letter. 

5 Select OK to continue downloading or select Cancel to stop.
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Communicate Menu, continued

Download 
Internal 
Memory 
Procedure, 
continued

Continued on next page

6 If communication failed due to the comport selected, the 
following display appears.

Select Yes if you want automatic detection of the comport and 
continue with next step. Select No otherwise. Return to step 1.

7 Downloading will commence with a Wait message for the 
connection to take place, then a progress display will appear as 
follows:

Data transfer will take about 3 minutes. Go to step 9.

8 If you choose Cancel, the operation will be terminated and the 
datafile to which the data is being written will be deleted.
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Communicate Menu, continued

Download 
internal 
memory, 
continued

Download 
memory card 

Selection of this command for downloading data from a memory card to a 
datafile is identical to the Download Internal Memory process. Although the 
methods for file selection and transfer are the same, the major differences are 
speed and memory card to floppy disk capacity compatiblility. 

NOTE: Do not attempt to save a memory card datafile that is larger in capacity 
than that of the floppy disk of the computer. If you do, an error message will be 
displayed. For example, a 2 Mb memory card will not download to a standard 
1.44 Mb floppy disk; however, a 512 kb or 1 Mb memory card will download 
correctly..

Downloading the data from a 1 Mb memory card of the PP4300  to a 
datafile (or 1.44 Mb floppy disk) takes about 10 minutes.

Continued on next page

9 If Auto-detect fails , the following message will appear:

Press F1 for help to resolve problem. Select OK to abort 
communications and return to Main Menu.

10 At the end of data transfer, the following message appears:

11 Select OK with mouse or press Enter key. 

12 The Main Menu will be displayed. Selection of DRAN-VIEW 
from the Browser menu will permit viewing of the datafile.
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Communicate Menu, continued

Download 
memory card 
Procedure

Perform the following procedure to download data from the memory card of the 
4300 to a designated file.

Continued on next page

Step Action

1 Connect the PP4300 to the computer. Turn on power to the 
PP4300.

2 Select Communicate, Link, then Download Memory Card 
commands. The following Save Data File display will appear.
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Communicate Menu, continued

Download 
memory card 
Procedure, 
continued

Continued on next page

3 Using the following options, specify the name and location of the 
file you are about to save.

File Name
Type the filename in which you want to save the data. A file-
name can contain up to eight characters and an extension of up 
to three characters. Files must have an extension of .evt to 
work with DRANVIEW, typing any other extension will pro-
duce an error. If you provide a filename only (without exten-
sion) DRAN-LINK 4300 adds the .evt extension for you.

Drives
Select the drive in which you want to store the document. 
Datafiles created by downloading from a memory card are 
larger than can be saved on a floppy disk. These files must be 
saved on a hard disk or an error display will be produced.

Directories
Select the directory in which you want to store the datafile.

Network
Choose this button to connect to a network location, assigning 
it a new drive letter. 

4 Select OK to continue downloading or select Cancel to stop.

5 Downloading will commence with a Wait message, then a 
progress display will appear as follows:

Data transfer will take about 20 minutes for a 2 Mb datafile.
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Communicate Menu, continued

Download 
memory card 
Procedure, 
continued

6 If you choose Cancel, the operation will be terminated and the 
datafile to which the data is being written will be deleted.

7 At the conclusion of data transfer, the following message appears:

8 Select OK with mouse or press Enter key. 

9 The Main Menu will be displayed. Selection of DRAN-VIEW 
from the Browser menu will permit viewing of the datafile.
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Browser Menu

Introduction Selection of the Browser command will enable the Browser menu only if the 
DRAN-VIEW application has been installed. If the Browser menu can be 
enabled, then selection of DRAN-VIEW can be performed.

If you have collected data from the PP4300 in the current DRAN-LINK session, 
DRAN-VIEW will automatically open the datafile and display the data when it 
starts. Refer to the DRAN-VIEW Operator’s manual for detailed operating 
instructions.

DRAN-SCAN is not available in this version of DRAN-LINK.
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Help Menu

Introduction The Help menu offers the following commands, which provide you with 
assistance with this application.

• Index - Offers you an index to topics on which you can get help.
• Using Help - Provides general instructions on using help.
• About DRAN-VIEW 4300 - Displays the version number of this application.

Index Use this command to display the opening screen of help, shown on the next 
page. From this opening screen, you can jump to step-by-step instructions for 
using DRAN-LINK and various types of reference information.

Once you open Help, you can click the Contents button whenever you want to 
return to the opening screen.

Index Screen

Continued on next page
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Help Menu, continued

Using Help Use this command for instructions about using help. The screen is shown below.

How to Use Help Display

Continued on next page
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Help Menu, continued

About DRAN-
LINK 4300 

Use this command to display the copyright and version number of your copy of 
DRAN-LINK 4300, shown below. 
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Exiting the Software

Introduction There are three ways to exit the software to end the DRAN-LINK session.

• File Menu - Select Exit. 
• From the Application Control Menu - Select Close.
• Double click the Control Menu button.

If you chose to exit DRAN-LINK during a data transfer operation, DRAN-
LINK 4300 must sign-off to the 4300 to end communications. This process will 
normally take several seconds to complete so that DRAN-LINK 4300 displays a 
wait message during this time. 
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